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Editing documents

Press ENTER or any letter/digit to edit the contents of the current cell. To accept new data press ENTER once again
or use one of the following cursor keys: Up, Dn, PgUp(+CTRL), PgDn(+CTRL). Pressing ESC will return the original
value. You can enter up to 256 characters. To add quickly an address of a particular cell to the currently edited cell,
press SHIFT and click this cell with the left mouse button.

If you want to scroll different parts of your document independently, use the Tile command from the Window
menu to split the view into two or fours panes. Use the F6 and F6+SHIFT keys to switch among different panes of

the current window.

You may select cells using mouse or the SHIFT key. If you want to select a group of objects (OLE objects or charts)
you must hold down SHIFT.

Press CTRL4+END if you want the document to be scrolled to the last column and the last row which contains data,
has some background color or frames, or is covered by some object.

See: Entering numbers, formulas and text, Functions, Operators



Entering numbers, formulas and text

GS-Calc automatically recognizes the type of the entered data. By default text cells are left-aligned. If you want the
given formula or number to be treated as a text string, you may enter the apostrophe (') as the first character (e.g.
'3/4+1). Formulas may begin with = or + (although it is not necessary). Numbers having more than 15 digits are
displayed in exponential format. You may use both the point (.) and the currently system-defined decimal separator
to input decimal places in numbers.

If the length of a number exceeds a column width, the program displays a string of "#" characters. To display and
print formulas instead of their values, clear the "Display values of formulas" checkbox in the Options dialog
box.

If you enter any formulas containing recurrent expressions (for example, B1 into the Al cell and Al into B1), the
program displays a list of cells causing such an iterative recalculation as the status bar message. The recurrence
level can be changed in the Options dialog box.

When entering formulas you may use absolute or relative cell addressing. If you copy formulas from one cell to
another, GS-Calc changes the relative addresses to reflect this movement. For example, "Al" copied from B1 to B2
will be replaced by "A2". To avoid this, enter a dollar sign ($) before columns (to preserve the column number) or
rows (to suppress the row change), e.g. $A$1, $Al, A$1. Clearing the "Modify cell addresses when copying
formulas" checkbox in the Options dialog box has the same effect.

Examples:

Numbers Formulas Text

5 Al+A2 abc
5,56 Al:B5 GSCALC
12,45e+12 $A1+A$2+$A$3 Table
-1995 A1/A2+FACT(A3) '123
23% "ab" & 'Al/45

IF(Al="cd";A2;A3) 123"
FVAL(1000;3%;A1)
FVAL(1000;0,03;A1)

See: Functions, Operators



Inserting graphics

To insert text, frames or tables as a graphics:

1. Select the data you want to use and choose the Copy command from the Edit menu.

2. Using the Paste special command from the Edit menu and selecting the "Graphics" format insert a new object
into your document.



Using Drag-Drop functions

Use the Drag-Drop functions to copy selected data or to open an existing GS-Calc document. To open an existing
document drag its name from within Explorer window to the GS-Calc window.



Copying cells and objects

Use the Edit menu commands or Drag-Drop functions to copy cells or objects. To copy data using Drag-Drop
functions:

1. Select cells or objects you want to copy.

2. Hold down CTRL key and using left mouse button drag the selection over a new place.

3. Release CTRL key and mouse button to finish copying.

Use Drag-Drop functions to copy data within the same document, different GS-Calc documents or different
applications. If you want to paste a link into another application press and hold down SHIFT key. Otherwise GS-Calc
will create an embedded object.



Using OLE functions

GS-Calc acts as an OLE client and server. It supports in-place-editing and Drag-Drop functions. GS-Calc objects
inserted into other applications look like documents printed directly from GS-Calc. Changing the in-place-edited
object's size results in increasing the number of displayed cells.

To change the size of the given GS-Calc linked object you may change its name in the client application. This name
includes four coordinates describing visible cells.

If you copy a chart to another program, GS-Calc creates an OLE object which consists of the smallest range of cells
covering both the chart and the cells where its data are placed.



Editing databases
After opening a database the rows contain subsequent records. You may edit databases like any other GS-Calc
document. GS-Calc performs text length validation as text fields are modified. Use the Update Records command to

save any changes you made.

Note: GS-Calc saves the current selection. If you don't select any cells, only one field of single record pointed by
the current cell will be updated.

If you want to add a new record, simply fill cells below the last row and save it. If you want to delete one or more
records, use the Remove Rows command from the Tools menu.

When opening and creating databases you may use the following record field types:

Type Length Description

in bytes

Text 0-255 Text and numbers.

Memo * Lengthy text. A Memo field's size is limited by the
maximum size of the database.

Long 4 Integer values from 2,147,483,648 to 2,147,483,647.

Boolean 1 Yes/No, True/False, 1/0. A field that contains only
one of two values.

Byte 1 Positive values from 0 to 255.

Integer 2 Integer values from -32,768 to +32,767.

Single 4 3.402823E38 to 1.401298E-45 for negative numbers
and 1.401298E-45 to 3.402823E38 for positive
numbers.

Double 8 Values from 1.79769313486232E308 to
4.94065645841247E-324 for negative values and
4.94065645841247E-324 to
1.79769313486232E308 for positive values.

Date 8 Dates and times (stored together). These values are
stored in a 8-byte field and may be treated as a 8-
byte floating point number. The (positive or
negative) integer portion represents the number of
days from 30 December 1899, midnight and the
fractional portion represents hours.

Long * Any value that can be represented in binary (like

binary pictures or OLE objects created in other programs)
up to 1.2 gigabytes in size.

Currency 8 Used for monetary values. This data type maintains

a fixed number of digits to the right of the decimal
point, which helps in avoiding improper rounding
during calculation.

If you choose a field type that doesn't apply to the given format, the type that matches it as close as possible will
be used. Please note that GS-Calc doesn't display the contents of binary fields and doesn't save binary and memo

fields.

When reading and saving records from databases DBF drivers convert text from OEM character set to ANSI
character set. If your DBF database uses the ANSI set, you may change drivers properties manually in the registry
database changing the value of the DataCodePage entry from OEM to ANSI in the key HKEY_LOCAL_MACHINE\
Software\Microsoft\Jet\3.0\Engines\Xbase.

By default GS-Calc displays empty record fields as empty cells. If you want any text to be used instead of empty



cells, edit the NullString entry in the HKEY_CURRENT_USER\Software\|PS Development\GS-Calc\Settings
key in the registry database.

GS-Calc treats Excel files as tables and does not use or convert any formulas when reading, modifying and creating
the *.xIs files. To open a range of cells in an Excel 5.0 or Excel 7.0 table, specify the table name followed by a dollar
sign and the starting and ending cells of the range (e.g. SHEET1$A1:B5).

To open and edit a Paradox database which has a primary key, the program needs both the database (*.db) and the
index file (*.px). If you open a Paradox database that doesn't have a primary key, you won't be able to update it.

The program opens Access databases (*.mdb) in read/write mode. To open an Access database placed on CD-ROM
or any other read-only media, you must copy it on your hard disk and remove the read-only file attribute.



Editing charts and OLE objects

To edit a chart, a rectangle or an ellipse double-click it. GS-Calc displays a dialog box which enables you to modify
its appearance. Double-clicking an OLE object causes the program to perform the first command from the
Edit/Object menu. Usually, this means activation and in-place-editing. If you press and hold down SHIFT key, the
subsequent command (if exists) from the same menu will be performed.

Note:
If you use commands from the Object menu instead of double-clicking, you will save some memory (if the current
undo level is greater than 0) but you will NOT be able to undo any changes of this object.



Using DDE commands

You may use the DDE communication to enter data into the given GS-Calc document. The DDE "execute" command
should have the following form:

[insert(file_name,column,row,value]

There should be no whitespaces between parameters and each parameter should be enclosed in quotation marks.
For example:

[insert("d:\gscalc35\analyze.gsc","2","11","4.5")]

The value parameter may represent a number or a text string. After accepting a new cell GS-Calc performs
recalculation and updates charts and associated OLE server items.

To open or print a document you may also use the following commands
[open(file_name)]

[print(file_name)]
[printto(file_name,printer_name,driver_name,port_name)]

When creating the application and item atoms during the DDE initiation use the "gscalc" and "system" text string.



Changing the number format

GS-Calc uses the format defined in Windows as a part of the current international settings. You may change it using
Control Panel.



Changing the currency, date and time format

GS-Calc uses the format defined in Windows as a part of the current international settings. You may change it using
Control Panel.



Changing the default font
GS-Calc saves some its parameters in the registry database. It uses the following key name:
HKEY_CURRENT_USER\Software\]PS Development\GS-Calc\Settings

Change value of the MainFont entry in this key to change the global font used by GS-Calc. The default name is
"Arial".



Commands

File menu
Edit menu
View menu
Insert menu
Format menu
Tools menu
Window menu

Help menu



File menu

Print Preview
Print Setup
Page Setup
Password
Summary Info
Send

Exit



Paste Special
Paste Link
Delete



View menu

Status Bar
Standard Toolbar
Format Toolbar



Insert Menu

New Object
Chart
Ellipse
Rectangle
Data Series
Formula



Format menu

Cell Properties
Bold

Italic
Underline
Strikeout
Normal
Font

Remove Formattin




Tools menu

Sort

Analyze menu
Insert Column
Remove Columns
Insert Row

Remove Rows

Move to Foreground
Move to Background
Recalculate

Options



Analyze menu

Equation System
Linear Optimization
Inverse Matrix
Determinant

Integration



Window menu

New Window
Split

Cascade

Tile Horizontally
Tile Vertically
Arrange Icons



Help menu

Help Topics
About GS-Calc



New command (File menu)

Use this command to create a new document in GS-Calc.



Open command (File menu)

Use this command to open an existing document in a new window. You can open multiple documents at once. Use
the Window menu to switch among the multiple open documents.

Note: It is important to select a proper file type from the File Types list in the Open dialog box.



Close command (File menu)

Use this command to close all windows containing the active document. GS-Calc suggests that you save changes to
your document before you close it. If you close a document without saving, you lose all changes made since the last
time you saved it.



Save command (File menu)

Use this command to save the active document to its current name and directory. If you want to change the name
and directory of an existing document before you save it, choose the Save As command.

Note: If you are editing a database, this command name is replaced by "Update Records".



Save As command (File menu)

Use this command to save and name the active document.



Page Setup command (File menu)

Use this command to change page layout.



Summary Info command (File menu)

Use this command to display a dialog box containing information about the current document.



Summary Info dialog box

GS-Calc displays information on the current document: the number of cells with particular contents, size of the
document file and the date of last saving.



Summary Info dialog box

GS-Calc displays information on the current document: the number of cells with particular contents, size of the
document file and the date of last saving.



Password command (File menu)

Use this command to change the current password.



1,2,3... command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you closed.
Choose the number that corresponds with the document you want to open.



Send command (File menu)

Use this command to send the active document through electronic mail. This command presents a mail window
with the active document attached to it. You may then fill out the To: field, Subject: field, etc., and add text to the
body of the message if you wish. When you are finished you may click the "Send" button to send the message.



Exit command (File menu)

Use this command to end your GS-Calc session.



Undo command (Edit menu)

Use this command to reverse the last editing action. The name of the command changes, depending on what the
last action was.



Redo command (Edit menu)

Use this command to redo the reversed editing action. The name of the command changes, depending on what the
last action was.



Repeat command (Edit menu)

Use this command to repeat the last editing action. The name of the command changes, depending on what the
last action was. This command is inactive for some types of actions.



Cut command (Edit menu)
Use this command to remove the currently selected data from the document and put it on the clipboard.
Cutting data to the clipboard replaces the contents previously stored there.

To cut:

(1) the cell contents - select cells and use this command; you can choose what should be cut:
format,

cells containing text,

cells containing numbers,

cells containing formulas,

all cells;

(2) object - select the object and use this command; if you want to select a group of objects hold down SHIFT key.



Copy command (Edit menu)
Use this command to copy selected data onto the clipboard.

Copying data to the clipboard replaces the contents previously stored there.



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point. This command is unavailable if
the clipboard is empty.



Delete command (Edit menu)
Use this command to remove the currently selected data from the document.

To delete:

(1) the cell contents - select cells and use this command; you can choose what should be cut:
format,

cells containing text,

cells containing numbers,

cells containing formulas,

all cells;

(2) object - select the object and use this command; if you want to select a group of objects hold down SHIFT key.



Formula command (Insert menu)

Use this command to paste a formula into the current cell. After choosing this command GS-Calc displays the Paste
Formula dialog box which enables you to retrieve all available formulas (shortcut: right mouse button + SHIFT).



Find command (Edit menu)

Use this command to search the active document for text. While comparing text GS-Calc uses unformatted cells
contents.

If you select any cells before using this command, the searching will be limited to those cells.



Find dialog box

See: Find command



Replace command (Edit menu)

Use this command to find and replace text in the active document. While comparing text GS-Calc uses unformatted
cells contents.

If you select any cells before using this command, the searching will be limited to those cells.



Replace dialog box

See: Replace command



Convert Formulas command (Edit menu)

Use this command to convert the selected formulas to numbers or text strings.



Object Properties command (Edit menu)

Use this command to change properties of the selected OLE object. You can change its type, the way it is displayed,
its scaling and link.



Standard Toolbar command (View menu)

Use this command to display and hide the Standard Toolbar, which includes buttons for some of the most
common commands in GS-Calc, such as File Open. A check mark appears next to the menu item when the toolbar
is displayed.



Standard Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick
mouse access to many tools used in GS-Calc.



Format Toolbar command (View menu)

Use this command to display and hide the Format Toolbar, which includes buttons for some of the most common
commands in GS-Calc. A check mark appears next to the menu item when the Toolbar is displayed.



Format Toolbar

The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick
mouse access to many tools used in GS-Calc.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the selected
menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to the menu item
when the Status Bar is displayed.



Status Bar

The status bar is displayed at the bottom of the GS-Calc window. To display or hide the status bar, use the Status
Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through
menus. This area similarly shows messages that describe the actions of toolbar buttons as you depress them,
before releasing them. If after viewing the description of the toolbar button command you wish not to execute the
command, then release the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate:

Indicator Description

AUTO  Formulas are recalculated automatically.
TRANS Modifying formulas after changing its location.
CAP Caps Lock is on.

NUM Num Lock is on.

SCRL Scroll Lock is on.



Zoom command (View menu)

Use this command to enlarge the view of the current document. Valid scaling factors are from 30 to 400%.



Grid command (View menu)

Use this command to hide or show the grid of the active document.



Chart command (Insert menu)

Use this command to insert a new chart. The displayed Chart dialog box enables you to select the chart type, data
and other options affecting its appearance. Initially all data come from the selected cells. You can change this using
the Data tab and the Change button. Depending on the current settings, one data series (function) may occupy a
single row or a single column of a cells range. Data series may be placed in rows/columns of the given single cells
range or may occupy up to 16 separated cells ranges. If you select more than one data range for the given chart
and if you want the chart to present more than one function, all ranges must contain the same number of cells. GS-
Calc uses formats of the respective document cells when displaying the values describing charts.

The 2D charts shown (on the chart list) with a horizontal grid use a logarithmic scale.

Charts are updated after every action that can change the document's contents. To edit an existing chart double-
click it. Hold down SHIFT key if you want to change the cells ranges of particular data series.



Chart Type dialog box

See: Chart command



Options dialog box

See: Chart command



Colors dialog box

See: Chart command



Data dialog box

Data...
Use this button to display the Chart Data dialog box. It enables you to specify cell ranges for each data category.

See: Chart command



Chart Data dialog box

The following options enables you to specify cell ranges for each data category;

Data

The cell range which contains values of one or more functions. You may select up to 16 different cells ranges. To
add a new one select a range that does not intersect the others.

X-Axis

The cell range containing values used to describe X axis of a chart.

Legend

The cell range containing values which are used to display the legend of a chart.

To change any range of cells select desirable cells and click the chosen button.



Data Series (Insert menu)

Use this command to insert a series of numbers or a text into the selected cells.



Ellipse command (Insert menu)

Use this command to insert a new ellipse into the active document. Double-click the inserted ellipse to specify
additional parameters.



Rectangle command (Insert menu)

Use this command to insert a new rectangle into the active document. Double-click the inserted rectangle to specify
additional parameters.



Cell Properties command (Format menu)

Use this command to change the properties of the selected cells. You may change the style, alignment, displaying
options, colors, frame and shadows.



Bold command (Format menu)

Use this command to select bold format.



Italic command (Format menu)

Use this command to select italic format.



Underline command (Format menu)

Use this command to select underline format.



Strikeout command (Format menu)

Use this command to select strikeout format.



Normal command (Format menu)

Use this command to select normal format.



Font command (Format menu)

Use this command to display the Font dialog box which enables you to specify font name, size, style, color and
effects.



Font dialog box

See: Font command



Remove Formatting (Format commands)

Use this command to remove formatting for the selected cells.



Sort command (Tools menu)

Use this command to sort the selected cells. The first column of the current range is treated as the sort key. If you
don't select any cells, the program will sort the current column.



Equation System command (Tools menu)

After using this command GS-Calc displays the Equation System dialog box which enables you to solve linear
equations.



Linear Optimization command (Tools menu)

After using this command GS-Calc displays the Linear Optimization dialog box which enables you to find optimal
solutions using linear programming.



Inverse Matrix command (Tools menu)

After using this command GS-Calc displays the Inverse Matrix dialog box which enables you to inverse matrixes.



Determinant command (Tools menu)

After using this command GS-Calc displays the Determinant dialog box which enables you to calculate
determinants of matrixes.



Integration command (Tools menu)

After using this command GS-Calc displays the Integration dialog box which enables you to perform integration of
functions.



Equation system dialog box

To solve an equation system:

1. Select cells containing variables and click the Variables button.

2. Select cells containing constants and click the Const. button. The number of these cells must be equal to the
number of rows selected in step 1.

3. Select cells which will contain the result and click the Result button. The number of these cells must be equal to
the number of columns selected in step 1.

4. Click the OK button.

Example

the equation system

X + 2%y + 4%z = 24

2*x +z=13

5x-y-z=15

can be expressed in the following way:

Variables - B3:D5
Constants - E3:E5
Results - B6:D6



Linear Optimization dialog box

To find an optimal solution using linear programming:

1. Select cells containing variables and click the Variables button.

2. Select cells containing constants and click the Const. button. The number of these cells must be equal to the
number of rows selected in step 1.

3. Select cells containing optimized function factors and click the Function button. The number of these cells must
be equal to the number of columns selected in step 1.

4. Select cells which will contain found variables and function value and click the Result button. The number of
these cells must be equal to the number of columns selected in step 1 plus one.

5. Click the OK button.

Note: The problem may have few symmetric solutions which should be pointed out of the obtained results.

When finding the solution GS-Calc maximizes a given function.
Example

Problem

X <= 4500

-0.65x + 0.35y <=0

5x + 8y -> max

can be expressed in the following way:

Variables - B11:C12
Constants - D11:D12
Function - B14:C14
Results - B15:D15



Inversion of Matrix dialog box

To find an inverted Matrix

1. Select cells containing the matrix and click the Data button.

2. Select cells which will contain the result. The number of these cells must be equal to the number of cells selected
in step 1.

3. Click the OK button.

To find a determinant

1. Select cells containing the matrix and click the Data button.

2. Select the cell which will contain the computed value and click the Result button.
3. Click the OK button.



Integration dialog box

To perform integration:
1. Select cells containing parameters and click the Parameters button. These cells must contain following values:
the down integration limit,
the upper integration limit,
the precision as a percentage.
The integrated function can have no values in the limit points.
2. Select the cell containing the integrated function and click the Function button. This function may consists of
any formulas and numbers. The variable must be expressed as the "x" letter.
4. Select the cell which will contain the computed value and click the Result button.

Example

Parameters - B5:D5 (integration from 1 to 100 at 0.01% relative precision)
Function - B6
Result - B7



Insert Column command (Tools menu)

Use this command to insert a new column. Inserting column may result in modifying formulas.
Example:
If you insert the D column, the formula E1+E2 from the Al cell will be replaced by F1+F2.



Remove Columns command (Tools menu)

Use this command to delete selected columns. Deleting columns may result in modifying formulas.
Example:
If you delete the D column, the formula E1+E2 from the Al cell will be replaced by D1+D?2.



Insert Row command (Tools menu)

Use this command to insert a new row. Inserting row may result in modifying formulas.
Example:
If you insert the 10th row, the formula E100+E200 from the Al cell will be replaced by E101+E201.



Remove Rows command (Tools menu)

Use this command to delete selected rows. Deleting rows may result in modifying formulas.
Example:
If you delete the 10th row, the formula E100+E200 from the Al cell will be replaced by E99+E199.



Change Width/Height (Tools menu)

Use this command to change the width or height of selected columns or rows.



Move To Foreground command (Tools menu)

Use this command to move the selected object(s) before any other objects.



Move To Background (Tools menu)

Use this command to move the selected object(s) behind any other objects.



Recalculate command (Tools menu)

Use this command to recalculate all formulas within the active document.



Options command (Tools menu)

Use this command to display the Options dialog box which enables you to change the program settings.



New Window command (Window menu)

Use this command to open a new window with the same contents as the active window. You can open multiple
document windows to display different parts or views of a document at the same time. If you change the contents
in one window, all other windows containing the same document reflect those changes. When you open a new
window, it becomes the active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Split command (Window menu)

Use this command to split the active window into panes. You may then use the mouse or the keyboard arrows to
move the splitter bars. When you are finished, press the mouse button or enter to leave the splitter bars in their
new location. Pressing ESC keeps the splitter bars in their original location.



Arrange Icons command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main window. If there is an
open document window at the bottom of the main window, then some or all of the icons may not be visible because
they will be underneath this document window.



1,2,3... command (Window menu)

GS-Calc displays a list of currently open document windows at the bottom of the Window menu. A check mark
appears in front of the document name of the active window. Choose a document from this list to make its window

active.



Help Topics command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-step
instructions for using GS-Calc and various types of reference information.



About GS-Calc command (Help menu)

Use this command to display the copyright notice and version number of your copy of GS-Calc.



Context Help command

Use the Context Help command to obtain help on some portion of GS-Calc. When you choose the Toolbar's Context
Help button, the mouse pointer will change to an arrow and question mark. Then click somewhere in the GS-Calc
window, such as another Toolbar button. The Help topic will be shown for the item you clicked.



Title Bar

The title bar is located along the top of a window. It contains the name of the application and document. To move
the window, drag the title bar.

Note: You can also move dialog boxes by dragging their title bars.



Scroll Bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars indicate
your vertical and horizontal location in the document. You can use the mouse to scroll to other parts of the
document.



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Editing documents



Installing GS-Calc

System requirements:
- PC with Windows 95/NT
- 4.5 MB free disk space (1.5 MB without database drivers).

To install GS-Calc run SETUP.EXE program from your first installation disk or from CD. After successful installation
GS-Calc displays message: "Installation complete.".

If the DAO database drivers have not been installed in your system, the following files will be copied to the
Windows\system directory.

DAO3032.DLL (to the \Program Files\Common Files\Microsoft Shared\Dao directory)
MSJT3032.DLL
MSJTER32.DLL
MSJINT32.DLL
VBAJET32.DLL
VBAR2232.DLL
VEN2232.0LB
MSVCRT20.DLL
MSRD2X32.DLL
MSXB3032.DLL
MSPX3032.DLL
MSXL3032.DLL

Note: GS-Calc uses these DLLs exclusively for importing and exporting data to the various formats.



Customer support

If have any problems with this product or if you have any suggestions, please contact:
JPS Development

ul. Chopina 13

58-100 Swidnica, Poland

tel.: 0048-74-537581
fax: 0048-74-537581

E-mail: support@jps-development.com
Web: http://www.jps-development.com



No information

No information on this topic.



No information

No information on this dialog box.



To change this data select the document cells and click this button. Click OK to update the chart.



Specifies the color you want to use to display the background.



Specifies the color you want to use to display the chart, its legend and titles.



Specifies how to fill the chart interior. If you choose Colors, it will be filled with solid colors. Otherwise it will be filled
with six predefined patterns.



Specifies the colors used to display subsequent functions. Click one of the buttons to change the desirable color.



Click this button to restore the default color set.



Specifies whether the chart grid should be displayed and printed.



Specifies the order used to display functions on 3D charts. If you choose this option the default order will be
reversed.



Specifies whether values of a single function are placed in a single row or in a single column.



Specifies whether a legend should be displayed.



Specifies whether a description of X axis should be displayed.



Clear this option to display on Y axis the smallest range of numbers containing all function values. If you check this
option, Y axis will start from O (for positive numbers).



Specifies the number of ticks displayed at Y axis. The default value is 5.



Specifies the chart title. You may enter up to 80 characters.



Click this button to display the Font dialog box which enables you to change fonts.



Click this button to display the Font dialog box which enables you to change fonts.



Click this button to display the Font dialog box which enables you to change fonts.



Displays all available charts.



Some of displayed charts can be used to present a numeric relation between functions and arguments. If you check
this option, the data describing X axis will be treated as values of arguments for a given function (or functions). The
number of ticks at X axis is equal to the number of arguments. The arguments don't have to be sorted in any way.



Specifies the cell ranges containing data for one or more functions. The list may consist of 16 different ranges. If
you want the ranges to represent more than one function, they must contain the same number of cells. To add/set a
new range select the Change button.



After selecting this button GS-Calc displays the Chart Data dialog box which enables you to change each data
range.
Note: To display this dialog quickly press SHIFT key and double-click the selected chart.



Specifies where the description of X axis and the chart legend are placed.



Specifies the name of the table and its fields you want to read. A check mark which appears in front of the field
name indicates that the field will be included. If you are opening a database which contains more than one table per
file, the name of the table may differ from the file name.



Specifies fields you want to read from the selected table.



Specifies the expression to be used as a filter for records you want to read. This may be a string conforming to the
SQL WHERE clause syntax. You may leave this field blank.

Examples:

(1) City>="Ne" AND Number=12

(2) City<= "W" OR Number>10

(3) (April_Sales+May_Sales+June_Sales)/3>50000

(4) Title+Name="Mr.Smith" OR Title+Name="Mr.Jones"
(5) Name LIKE "*son"

Note: You must use square brackets if the field name contains spaces or some special characters (e.g. "[Product
number]").



Specifies whether you want to sort records.



Specifies the field that will be used as a sort key. By default GS-Calc performs ascending sorting. If you want to
perform descending sorting, add the DESC keyword to the selected field name (e.g. "Name DESC" instead of
"Name").

Note: You must use square brackets if the field name contains spaces or some special characters (e.g. "[Product
number]").



Specifies the field name in a newly created table.



Specifies the type of a field in a newly created table. You have to choose one of several predefined types. After
retrieving spreadsheet columns the program initially selects one of them.

Type Length in  Description
bytes

Text 0-255 Text and numbers.

Memo * Lengthy text, such as comments or explanations. A Memo
field's size is limited by the maximum size of the database.

Long 4 Integer values from 2,147,483,648 to 2,147,483,647.

Boolean 1 Yes/No, True/False, 1/0. A field that contains only one of
two values.

Byte 1 Positive values from 0 to 255.

Integer 2 Integer values from -32,768 to +32,767.

Single 4 3.402823E38 to 1.401298E-45 for negative numbers and
1.401298E-45 to 3.402823E38 for positive numbers.

Double 8 Values from 1.79769313486232E308 to

4.94065645841247E-324 for negative values and
4.94065645841247E-324 to 1.79769313486232E308 for
positive values.

Date 8 Dates and times (stored together). These values are stored
in a 8-byte field and may be treated as a 8-byte floating
point number. The (positive or negative) integer portion
represents the number of days from 30 December 1899,
midnight and the fractional portion represents hours.

Long * Any value that can be represented in binary (like pictures

binary or OLE objects created in other programs) up to 1.2
gigabytes in size.

Currency 8 Used for monetary values. This data type maintains a fixed

number of digits to the right of the decimal point, which
helps in avoiding improper rounding during calculation.

Specifies the length of a field in a newly created table. Only text field length can be changed.



Specifies the list of currently defined fields. To change properties of a given field select it and edit its description.



Specifies the columns or rows you want to delete.



Ascending sorting of selected data.



Descending sorting of selected data.



Specifies the type of data that will be inserted into the active document.



Specifies the first inserted value. The size of the series is determined by the size of the current selection.



Specifies the text which has to be inserted into document. The size of the series is determined by the size of the
current selection.



Specifies the numbers of empty cells between inserted cells.



Specifies the step by which subsequent values are incremented. This can be any number with or without decimal
places.



Specifies the horizontal alignment for the selected cells.



Specifies the vertical alignment for the selected cells.



Specifies the style for the selected cells.



Specifies the number of decimal places you want to use while displaying numbers.



Specifies whether separators in numbers in numbers should be displayed.



Specifies whether a multiline displaying should be use for the selected cells.



Specifies whether the selected cells should be protected.



Specifies whether the contents of the selected cells should be hidden.



Specifies the cell color.



Specifies the pattern to be used to fill the selected cells.



Specifies whether the selected cell color should be applied.



Specifies whether the selected font color should be applied.



Specifies whether the selected shadow should be applied.



Specifies the shadow color.



Specifies the horizontal and vertical offset of a shadow. These values are treated as a percentage respectively of
the average character width and height.



Specifies whether the frames with selected edges should be displayed.



Specifies the frame edges you want to display.



Specifies the frame thickness.



Specifies the frame color.



Specifies whether you want to use round frames.



Specifies whether you want to display frame around the current selection.



Specifies the group of formulas.



Displays all formulas from the selected group. To paste one of them into the active document double-click it.



Displays descriptions of formulas.



Specifies the current password. The password can consist of 15 characters.



Specifies the current password. The password can consist of 15 characters.



Specifies whether you want the password to be checked only when saving the document. Otherwise it will be
checked each time you try to open the document.



Specifies the current password.



Specifies the text printed at the top (header) and at the bottom (footer) of each printed page. It may contain up to
80 characters. You may place the following special characters within this text:

&fF Filename

&s File date

&z File time

&d Current system date

&e Current system date (long format)

&t Current system time

&p Page number

&I Left aligned (starting from the next character and up to
the end or to &r/&c characters)

&r Right aligned (starting from the next character and up to
the end or to &l/&c characters)

&c Centered (starting from the next character and up to the

end or to &l/&r characters)

Specifies the position of headers and footers.



Specifies whether you want to start the page numbering and the printing headers or footers from the first page.



Specifies whether to print row and column headers.



Specifies whether you want to shrink the printed document so that it can be printed on a single page.



Specifies how the current document should be scaled when printing.



Specifies the width of each margin on printed page.



Specifies whether you want to center printed cells horizontally (Horizontal Adjustment) or vertically (Vertical
Adjustment).



Specifies the line thickness.



Specifies the line color.



Specifies the interior color.



Specifies whether you want to display the object interior.



Specifies whether you want the rectangle corners to be round.



To choose a new data range select cells and click a desirable button.



Specifies the author name.



Specifies the notes which will be stored with the active document file.



Specifies the title of the active document.



Specifies the subject of the active document.



Specifies the document size.



Displays the date of last saving.



Displays the number of cells containing text, formulas and numbers.



Specifies the recurrence level. This is the number of circular recalculations the program performs after finding the
recurrence references. For example, if Al contains A1+1 and this value is equal to 10, the final value (in Al) will be
10. The list of cells causing such iterations is displayed as a status bar message.



Specifies whether all formulas should be recalculated after each action which may change the document contents.
If this option is not selected, formulas are recalculated after using the Recalculate command from the Tools menu.



Specifies the undo level. You may enter values from 0 to 16347.



Specifies how the current selection should be scrolled after pressing the Enter key.



Specifies whether to display computed values of formulas.



Specifies whether the program should use only True-Type fonts when formatting. If you don't select this option, you
will be able to apply any currently installed Windows font.



Specifies whether you want the formulas to be modified when copying or moving data. This option doesn't affect
formulas containing the "$" operator.



Specifies whether the formulas having a constant value (i.e. not containing references) are automatically converted
to numbers or text values.



Specifies the displaying scale.



Specifies the character set you want to use when opening or saving the text file. If you choose DOS character set,
GS-Calc will perform conversion from the DOS to the ANSI set.



Select the type of the cell separator you want to use when opening or saving the text file.



Specifies whether formulas or their values should be used when saving the text file.



Specifies whether formatted (containing separators and currency or percent symbols) should be used when saving
the text file.



Operators

Operato

r

<>

%

Operation

Equal

Less than

Greater than

Less than or equal

Greater than or
equal

Not equal

Addition
Subtraction
String
concatenation
Multiplication
Division

To the power of
Negative

Cells range

Percent

Comments

Compares numbers or text strings
(the comparison is not case-
sensitive). Example: A1 =4 , B2
= "abc"

Compares numbers or text strings
(the comparison is not case-
sensitive).

Example: A1 <4 , B2 < "abc"
Compares numbers or text strings
(the comparison is not case-
sensitive).

Example: A1 >4 , B2 > "abc"
Compares numbers or text strings
(the comparison is not case-
sensitive).

Example: Al<=4 , B2 <= "abc"
Compares numbers or text strings
(the comparison is not case-
sensitive).

Example: Al >=4 , B2 >=

"abc
Compares numbers or text strings
(the comparison is not case-
sensitive).

Example: A1l <>4 , B2 <>
"abc
Adds numbers.
Subtracts numbers.
Merges text strings.
Example: A1 & "abc"
Multiplies numbers.
Divides numbers.
Calculates the power of.
Changes the sign of a number.
Example: -Al

Creates a cells range.

Example: A1:B5

Specifies a number entered as a
percentage.

Example: 12%

g & ||b||

Precedence

[e)Ie)]

w b~ U1,



Functions

mathematical functions
statistical functions

lookup and reference functions
financial functions

date/time functions

text functions

logical functions

special functions



PRODUCT
PRODUCTIF
RADIANS
RAND
ROUND
ROUNDE
ROUNDO
ROUNDX




XOR

Hyperbolic functions



Statistical functions



ocT
PROPER
REPEAT
REPLACE
RIGHT
RTRIM
STEXT







Date/Time functions

DATE
DATEDIF
DATEVALUE
DAY
DAYOFWEEK
DAYOFYEAR
FORMATDATE
FORMATTIME
HOUR
MINUTE
MONTH
NOW
SECOND
TIME
TIMEVALUE
TODAY

YEAR



Lookup and Reference functions

COUNTV
GETEXVAL
HLOOKUP
INDEX
MATCH
OFFSET
RANGE
ROWS
VLOOKUP




Logical functions




Special functions

OPENDOC
OPENSHEET
MESSAGE
PLAYSOUND



ABS(Number)

Returns the absolute value of Number.

Example: ABS(-10) = 10



SGN(Number)

Returns -1 if Number < 0, 0 if Number = 0 and 1 if Number > 0.

Example: SGN(10) =1



AND(Numberl; Number2)

Returns the bitwise AND of Numberl and Number2.

Example: AND(12; 4) = 4



NOT(Number)

Returns the bitwise negation of Number.

Example: NOT(10) = -11



OR(Numberl; Number2)

Returns the bitwise OR of Numberl and Number2.

Example: OR(8; 4) = 12



XOR(Numberl; Number2)

Returns the bitwise XOR of Numberl and Number2.

Example: XOR(12; 4) = 8



ARCOSH(Number)

Returns the inverse hyperbolic cosine of Number.

Example: ARCOSH(1.5) = 0.96242365



ARSINH(Number)

Returns the inverse hyperbolic sine of Number.

Example: ARSINH(1.5) = 1.19476322



ARTGH(Number)

Returns the inverse hyperbolic tangent of Number.

Example: ATGH(0.5) = 0.54930614



COSECH(Number)

Returns the hyperbolic cosecant of Number.

Example: COSECH(1.5) = 0.46964244



COSH(Number)

Returns the hyperbolic cosine of Number.

Example: COSH(1.5) = 2.35240962



SECH(Number)

Returns the hyperbolic secant of Number.

Example: SECH(1.5) = 0.42509603



SINH(Number)

Returns the hyperbolic sine of Number.

Example: SINH(1.5) = 2.12927946



TANH(Number)

Returns the hyperbolic tangent of Number.

Example: TANH(1.5) = 0.90514825



ACOS(Number)

Returns the arccosine of Number.

Example: ACOS(0.5) = 1.04719755 (=PI/3)



ASIN(Number)

Returns the arcsine of Number.

Example: ASIN(0.5) = 0.52359878 (=PI/6)



ATAN(Number)

Returns the arctangent of Number.

Example: ATAN(1) = 0.78539816 (P1/4)



COS(Number)

Returns the cosine of Number.

Example: COS(PI(1)/3) = 0.5



SIN(Number)

Returns the sine of Number.

Example: SIN(PI(1)/6) = 0.5



TAN(Number)

Returns the tangent of Number.

Example: TAN(PI(1)/4) =1



BJO(Number)

Returns the value of the Bessel function of the first kind and zero level for Number.

Example: BJ0(0.9) = 0.8075238



BJ1(Number)

Returns the value of the Bessel function of the first kind and second level for Number.

Example: BJ1(0.9) = 0.40594955



BJN(Level; Number)

Returns the value of the Bessel function of the first kind for the given Level and Number.

Example: BJN(1;0.9) = 0.40594955



BYO(Number)

Returns the value of the Bessel function of the second kind and zero level for Number.

Example: BY0(0.9) = 0.00562831



BY1(Number)

Returns the value of the Bessel function of the second kind and first level for Number.

Example: BY1(0.9) = -0.87312658



BYN(Level; Number)

Returns the value of the Bessel function of the second kind for the given Level and Number.

Example: BY1(1; 0.9) = -0.87312658



DEGREES(Number)

Converts Number, which represents an angle in radians, to degrees.

Example: DEGREES(PI(1)/4) = 45



RADIANS(Number)

Converts Number, which represents an angle in degrees, to radians.

Example: RADIANS(45) = 0.78539816 (=PI(1)/4)



EXPM(Number)

Returns the mantissa m of Number (m is greater than or equal to 0.5 and less than 1) so that Number = m*2~k,
where k is the exponent.

Example: EXPM(1.5) = 0.75



EXPE(Number)

Returns the exponent k of Number so that Number = m*2~k, where m is the mantissa.

Example: EXPE(1.5) =1



EXP(Number)

Returns the base of the natural logarithm ("e") raised to the power of Number.

Example: EXP(2) = 7.3890561



FACT(Number)

Returns the factorial of Number: the product of all integers greater than zero and not greater than Number.

Example: FACT(5) = 120



GCD(Numberl; Number2)

Returns the greatest common divisor of Numberl and Number?2.

Example: GCD(24;16) = 8



SCM(Numberl; Number2)

Returns the smallest common multiplicity of Numberl and Number2.

Example: SCM(12; 8) = 24



LOG10(Number)

Returns the base 10 logarithm of Number.

Example: LOG10(100) = 2



LOG(Number)

Returns the natural logarithm of Number.

Example: LOG(EXP(2)) = 2



LOGX(Number; Base)

Returns the Base logarithm of Number.

Example: LOGX(275;2) =5



MOD(Numberl; Number2)

Returns the reminder of Numberl | Number2.

Example: MOD(9; 4) =1



POW10(Number)

Returns 10 to the power of Number.

Example: POW10(2) = 100



PI(Number)

Returns the product of Number and the value Pl (3.141592653589).

Example: PI(1) = 6.2831853



CEIL(Number)

Returns a number representing the smallest integer greater than or equal to Number.

Example: CEIL(2.6) = 3



ROUND(Number)

Returns Number rounded to the nearest integer.

Example: ROUND(2.4) = 2



ROUNDE(Number)
Returns Number rounded to the nearest even number.
Example: ROUNDE(3.1) = 4

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier
version of GS-Calc. In GS-Calc 3.5 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



EVEN(Number)

Returns Number rounded to the nearest even number.

Example: EVEN(3.1) = 4



ROUNDO(Number)
Returns Number rounded to the nearest odd number.
Example: ROUNDO(2.1) = 3

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier
version of GS-Calc. In GS-Calc 3.5 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



ODD(Number)

Returns Number rounded to the nearest odd number.

Example: ODD(2.1) = 3



ROUNDX(Number; Precision)

Returns Number rounded to the factor specified by Precision.

Example: ROUNDX(2.1; 0.5) = 2.5



TRUNC(Number)

Returns the integer portion of Number.

Example: TRUNC(2.5) = 2



SHIFTL(Number; Positions)

Returns the value of Number after shifting its bits by Positions to the left.

Example: SHIFTL(2; 3) = 16



SHIFTR(Number; Positions)

Returns the value of Number after shifting its bits by Positions to the right.

Example: SHIFTR(16; 3) = 2



SQR(Number)

Returns the square of Number.

Example:SQR(3) =9



SQRT(Number)

Returns the square root of Number.

Example: SQRT(9) = 3



INTERPOL(X_range; Y_range; Point)
Performs interpolation of a function in Point based on points from X_range and function values from Y_range.

Example: INTERPOL(A1:A10; B1:B10; 3) = 2.3



AREA(Range)

Returns the number of cells in Range.

Example: AREA(A1:B10) = 20



AVE(Range)

Returns the arithmetic mean for cells in Range.

Exampe: AVE(A1:B10) = 1.1



AVE2(Range)

Returns the square mean for cells in Range.

Example: AVE2(A1:B10) = 1.1



AVEG(Range)

Returns the geometric mean for cells in Range.

Example: AVEG(A1:B10) = 1.1



AVEH(Range)

Returns the harmonic mean for cells in Range.

Example: AVEH(A1:B10) = 1.1



CHI2(Degree; Chi2Expression)

Returns the confidence level for Chi2Expression, which has the chi-square distribution.

Example: CHI2(4; 1.1) = 0.89427221



STD(Degree; TExpression)

Returns the confidence level for TExpression, which has the Student distribution.

Example: STD(4; 1.1) = 0.33308365



COMBNR(n;k)

Returns the number of k-element combinations with repeating from the n-element set.

Example: COMBNR(5; 3) = 35



COMBNS(n; k)

Returns the number of k-element combinations without repeating from the n-element set.

Example: COMBNS(5; 3) = 10



CORREL(Rangel; Range2)

Returns the correlation between numbers from Rangel and RangeZ2.

Example: CORREL(A1:A10; B1:B10) = 0.9



COUNT(Range)

Returns the number of not empty cells in the given range.

Example: COUNT(A1:B10) = 4



COUNTV(Value; SearchRange)

Returns the number of cells containing Value in the given range. Value may represent a number or a text.

Example: COUNTV(2.2; A1:B10) = 3



ENTROPY(Range)

Returns the entropy of an information source based on probability factors from the given range.

Example: ENTROPY(A1:A2) = 1



ERF(Number)

Returns the integral of the Gauss function in the range {-Number*sqrt(2), Number*sqrt(2)}.

Example: ERF(1.5) = 0.96610809



ERFV(Number)

Returns the argument for which the ERF function returns Number.

Example: ERFV(0.96610809) = 1.5



EST(Range)

Returns the standard deviation of a sample from the given range.

Example: EST(A1:B10) = 1.1



ESTN(Range)

Returns the standard deviation of a population.

Example: ESTN(A1:B10) = 1.1



GRANDTOTAL(Range)

Returns the sum of values of formulas from the given range containing the SUBTOTAL function.

Example: GRANDTOTAL(A1:B10) = 12



SUBTOTAL(Range)

Returns the sum of numbers from the given range.

Example: SUBTOTAL(A1:B10) = 12



MAX(Range)

Returns the largest number in the given range.

Example: MAX(A1:B10) =5



MIN(Range)

Returns the smallest number in the given range.

Example: MIN(A1:B10) = -1



PRODUCT(Range)

Returns the product of not empty cells from the given range.

Example: PRODUCT(A1:B10) = 24.6



RAND(Number)

Returns a random number greater or equal to 0 and less or equal to Number.

Example: RAND(60) = 34.56



SUM(Range)

Returns the sum of numbers from the given range.

Example: SUM(A1:B10) = 14



SUM2(Range)

Returns the sum of squares of numbers from the given range.

Example: SUM2(A1:B10) = 34



SUM3(Range)

Returns the sum of cubes of numbers from the given range.

Example: SUM3(A1:B10) = 46.55



PRODUCTIF(Valuel; Value2; ConditionsRange; InputRange)

Returns the product of numbers from InputRange. Finds only those numbers, for which values at the same position
in ConditionRange fulfill the requirements:

(a) value > Valuel and value < ValueZ2 if Valuel and Value2 are not equal

or

(b) value = Valuel if Valuel is equal to Value2.

Valuel and Value2 may represent numbers or text strings. ConditionRage and InputRange must contain the same
number of cells.

Example: PRODUCTIF(10248; 10252; A2:A7; C2:C7) = 72




SUMIF(Valuel; Value2; ConditionsRange; InputRange)

Returns the sum of numbers from InputRange. Finds only those numbers, for which values at the same position in
ConditionRange fulfill the requirements:

(a) value > Valuel and value < ValueZ2 if Valuel and Value2 are not equal

or

(b) value = Valuel if Valuel is equal to ValueZ2.

Valuel and Value2 may represent numbers or text strings. ConditionRage and InputRange must contain the same
number of cells.

Example: SUMIF(10248; 10252; A2:A7; C2:C7) = 13




SUMIF2(Valuel; Value2; ConditionsRange; InputRange)

Returns the sum of squares of numbers from InputRange. Finds only those numbers, for which values at the same
position in ConditionRange fulfill the requirements:

(a) value > Valuel and value < ValueZ2 if Valuel and Value2 are not equal

or

(b) value = Valuel if Valuel is equal to ValueZ2.

Valuel and Value2 may represent numbers or text strings. ConditionRage and InputRange must contain the same
number of cells.

Example: SUM2IF(10248; 10252; A2:A7; C2:C7) = 61




SUMIF3(Valuel; Value2; ConditionsRange; InputRange)

Returns the sum of cubes of numbers from InputRange. Finds only those numbers, for which values at the same
position in ConditionRange fulfill the requirements:

(a) value > Valuel and value < Value2 if Valuel and Value2 are not equal

or

(b) value = Valuel if Valuel is equal to ValueZ2.

Valuel and Value2 may represent numbers or text strings. ConditionRage and InputRange must contain the same
number of cells.

Example: SUM2IF(10248; 10252; A2:A7; C2:C7) = 307




BIN(Number)

Returns the text string representing Number in the binary notation.

Example: BIN(23) = "10111"



CHAR(Number)

Returns a text string consisting of one character with the character set code equal to Number.

Example: CHAR(65) = "A"



CODE(Text)

Returns the character set code of the first character in Text.

Example: CODE("Word") = 87



HEX(Number)

Returns the text string representing Number in the hex notation.

Example: HEX(1998) = "7ce"



KWOTA(Number)



OCT(Number)

Returns the text string representing Number in the octal notation.

Example: OCT(1998) = "3716"



TEXT(Number)

Returns the text string representing Number in textual ("verbal") form.

Example: TEXT(23) = "twenty three"



EXACT(Textl; Text2)

Compares two text strings. If Textl = Text2, 1 (True) is returned. If they are different, 0 (False) is returned. The
comparison is case-sensitive.

Example: EXACT("Thing"; "Thing") = 1



FIND(Textl; Text2; Position)

Returns the position (as a 1-base index) of Textl in Text2. Searching starts in Text2 from Position.

Example: FIND("word"; "two words"; 1) =5



LEFT(Text; Number)

Returns the first Number characters from Text.

Example: LEFT("abcdef"; 3) = "abc"



LENGTH(Text)

Returns the length of Text.

Example: LENGTH("abcdef") = 6



LOWER(Text)

Converts all letters in Text to lowercase.

Example: LOWER("ABCDEF") = "abcdef"



REPLACE(Textl; Numberl; Number2; Text2)

Replaces Number2 characters in Textl starting from Numberl position by Text2. For the first character in Text1
Numberl = 1.

Example: REPLACE("abcdef"; 3; 2; "x") = "abxef"



STEXT(Text)
Converts all letters in Text to lowercase.
Example: STEXT("ABCDEF") = "abcdef"

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier
version of GS-Calc. In GS-Calc 3.5 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



MID(Text; StartPosition; EndPosition)

Returns the substring of Text. The substring starts at StartPosition and includes all characters up to EndPosition. The
position of the first character in Text is 1.

Example: MID("abcdef"; 3; 4) = "cd"



PROPER(Text)

Converts first letters of words in Text to uppercase and all other letters to lowercase.

Example: PROPER("two WORDS") = "Two Words"



REPEAT(Text; Number)

Returns string that consists of Text repeated Number times.

Example: REPEAT("abc "; 3) = "abc abc abc "



RIGHT(Text; Number)

Returns the last Number characters from Text.

Example: RIGHT("abcdef"; 3) = "def"



TRIM(Text)

Removes all trailing and leading whitespaces from Text.

Example: TRIM(" abcdef ") = "abcdef"



LTRIM(Text)

Removes all leading whitespaces from Text.

Example: LTRIM(" abcdef") = "abcdef"



RTRIM(Text)

Removes all trailing whitespaces from Text.

Example: RTRIM("abcdef ") = "abcdef"



UPPER(Text)

Converts all letters in Text to uppercase.

Example: UPPER("abcdef") = "ABCDEF"



ETEXT(Text)
Converts all letters in Text to uppercase.
Example: ETEXT("abcdef") = "ABCDEF"

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier
version of GS-Calc. In GS-Calc 3.5 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



TRAIL(Text; Number)

If Text length is less than Number, this function adds trailing spaces to Text so that Text contains exactly of Number
characters.

Example: TRAIL("abc", 6) = "abc "



VALUE(Text)

Converts Text to number.

Example: VALUE("123") = 123



NUM2STR(Number; Radix)

Returns the text string representing Number in the Radix notation.

Example: NUM2STR(1998; 10) = "1998"



MERGE (Textl; Text2)

Returns the text string consisting of merged Textl and Text2.

Example: MERGE("abc"; "def") = "abcdef"



CTERM(Rate; Fv; Pv)

Returns the number of compounding periods after which the initial amount (Pv) will obtain the value specified by Fv
at the given interest rate Rate.

Example: CTERM(9%/12; 10000; 5000) = 92.76576606



FVAL(Pv; Rate; Periods)

Returns the future value of an investment or loan Pv (with no periodic payments) at the given interest rate and the
given number of periods.

Example: FVAL(5000; 9%/12; 93) = 10017.51731932



FV(Payment; Rate; Periods)

Returns the future value of an investment (with periodic payments) after the given number of periods and with the
given interest rate.

Example: FV(500; 9%/12; 24) = 13094.23529284



PMT(Pv; Rate; Periods)

Returns the payment amount for a loan during the given number of periods.

Example: PMT(20000; 9%/12; 24) = 913.69484558



PV(Payment; Rate; Periods)
Returns the present value for a loan or investment.

Example: PV(500; 9%/12; 24) = 10944.57306872



RATE(Fv; Pv; Periods)

Returns the periodic interest rate for a loan or investment (Pv) at the given number of periods.

Example: RATE(10000; 5000; 48) = 0.01454533



SLN(Cost; Salvage; Life)

Returns the straight-line depreciation for one period.

Example: SLN(3000; 400; 5) = 520



SYD(Cost; Salvage; Life; Period)

Returns the sum-of-the-years'-digits' depreciation for the given period.

Example: SYD(3000; 400; 5; 4) = 346.66666667



TERM(Payment; Rate; Pv)
Returns the number of payment periods for an investment or loan (Pv) with the given interest rate and payment.

Example: TERM(500; 9%/12; 10000) = 18.7047196



DATE(Year; Month; Day)

Returns the date/time number for the given Year, Month and Day. This integer portion represents the number of
days from 30 December 1899, midnight and the fractional portion represents hours.

Example: DATE(1998; 1; 1) = 35796



TIME(Hour; Minute; Second)

Returns the date/time number for the given Year, Month and Day. This integer portion represents the number of
days from 30 December 1899, midnight and the fractional portion represents hours.

Example: TIME(11; 53; 44) = 0.49564815



DATEDIF(DateNumberl; DateNumber2; Type)

Calculates the difference between two dates. The result depends on Type:
1 - difference as the number of days

2 - remaining hours of the difference

3 - remaining minutes of the difference

4 - remaining seconds of the difference

5 - difference as the total number of hours

6 - difference as the total number of minutes

7 - difference as the total number of seconds

Example: DATEDIF(DATE(1998;3;1)+TIME(10;45;0); DATE(1998;1;1)+TIME(9;45;0); 6) = 85020 (minutes)



DATEVALUE(Text)

Returns the date/time number for the given date formatted as Text. To be parsed correctly, the text string must
conform to the currently defined in system short date/time format.

Example: DATEVALUE("13/1/98") = 35808



TIMEVALUE(Text)

Returns the date/time number for the given time formatted as Text. To be parsed correctly, the text string must
conform to the currently defined in system short date/time format.

Example: TIMEVALUE("9:45:34 PM") = 0.90664352



DAY (DateNumber)

Returns the day of the month (1-31) for the DateNumber.

Example: DAY(DATE(1998;1;1)) = 1



HOUR(DateNumber)

Returns the hour(0-23) for the DateNumber.

Example: HOUR(TIME(23;12;56)) = 23



MINUTE(DateNumber)

Returns the minute (0-59) for the DateNumber.

Example: MINUTE(TIME(23;12;56)) = 12



SECOND(DateNumber)

Returns the second (0-59) for the DateNumber.

Example: SECOND(TIME(23;12;56)) = 56



MONTH(DateNumber)

Returns the month (1-12) for the DateNumber.

Example: MONTH(DATE(1998;1;1)) = 1



YEAR(DateNumber)

Returns the year for the DateNumber.

Example: YEAR(DATE(1998;1;1)) = 1998



DAYOFWEEK(DateNumber)

Returns the day of the week (Sun = 1) for the DateNumber.

Example: DAYOFWEEK(DATE(1998;1;1)) = 5



DAYOFYEAR(DateNumber)

Returns the day of the year (Jan 1 = 1) for the DateNumber.

Example: DAYOFYEAR(DATE(1998;1;1)) = 1



FORMATDATE(DateNumber; FormattingText)

Returns the text representing date/time formatted according to FormattingText. If FormattingText is an empty string
(""), the default Windows format for the date representation is used. Otherwise, it may contain any text combined
with the following special character sequences:

%a Abbreviated weekday name

%A Full weekday name

%b  Abbreviated month name

%B  Full month name

%c Date and time representation appropriate for locale

%d Day of month as decimal number (01 - 31)

%H  Hour in 24-hour format (00 — 23)

%l Hour in 12-hour format (01 — 12)

%j Day of year as decimal number (001 — 366)

%m  Month as decimal number (01 - 12)

%M  Minute as decimal number (00 - 59)

%p Current locale’s A.M./P.M. indicator for 12-hour clock

%S Second as decimal number (00 — 59)

%U  Week of year as decimal number, with Sunday as first day of week (00 - 51)
%w Weekday as decimal number (0 — 6; Sunday is 0)

%W  Week of year as decimal number, with Monday as first day of week (00 - 51)
%x Date representation for current locale

%X Time representation for current locale

%y Year without century, as decimal number (00 — 99)

%Y Year with century, as decimal number

%z, %Z Time-zone name or abbreviation; no characters if time zone is unknown
%% Percent sign

%+#c Long date and time representation

%#x Long date representation, appropriate to current locale

%#d, Yo#tH, Y%#1, Yo#j, Yotm, %#M, %#S, %#U, Y%#w, %o#W, %#y, Y%o#Y Remove leading zeros in the values
explained above

Example:
FORMATDATE(DATE(1998;1;1); "") = "1/1/98"
FORMATDATE(DATE(1998;1;1); "%A, %B") = "Thursday, January"
FORMATDATE(DATE(1998;1;1)+TIME(10;30;0); "%#c") = "Thursday, January 01, 1998 10:30:00"



FORMATTIME(DateNumber; FormattingText)

Returns the text representing date/time formatted according to FormattingText. If FormattingText is an empty string
(""), the default Windows format for the date representation is used. Otherwise, it may contain any text combined
with the following special character sequences:

%a Abbreviated weekday name

%A Full weekday name

%b  Abbreviated month name

%B  Full month name

%c Date and time representation appropriate for locale

%d Day of month as decimal number (01 - 31)

%H  Hour in 24-hour format (00 — 23)

%l Hour in 12-hour format (01 — 12)

%j Day of year as decimal number (001 — 366)

%m  Month as decimal number (01 - 12)

%M  Minute as decimal number (00 - 59)

%p Current locale’s A.M./P.M. indicator for 12-hour clock

%S Second as decimal number (00 — 59)

%U  Week of year as decimal number, with Sunday as first day of week (00 - 51)
%w Weekday as decimal number (0 — 6; Sunday is 0)

%W  Week of year as decimal number, with Monday as first day of week (00 - 51)
%x Date representation for current locale

%X Time representation for current locale

%y Year without century, as decimal number (00 — 99)

%Y Year with century, as decimal number

%z, %Z Time-zone name or abbreviation; no characters if time zone is unknown
%% Percent sign

%+#c Long date and time representation

%#x Long date representation, appropriate to current locale

%#d, Yo#tH, Y%#1, Yo#j, Yotm, %#M, %#S, %#U, Y%#w, %o#W, %#y, Y%o#Y Remove leading zeros in the values
described above

Example:
FORMATTIME(TIME(10;30;45); "") = "10:30:45 AM"
FORMATTIME(TIME(10;30;45); "minutes: %M, seconds: %S") = "minutes: 30, seconds: 45"
FORMATTIME(DATE(1998;1;1)+TIME(10;30;0); "%#c") = "Thursday, January 01, 1998 10:30:00"



TODAY(DaysNumber)
Returns the current date/time number +/- DaysNumber.

Example: TODAY(0) = "12/11/97"



NOW(HoursNumber)

Returns the current date/time number +/- HoursNumber.

Example: NOW(0) = "2:49:43 PM"



COLS(Range)

Returns the number of columns in Range.

Example: COLS(A1:B10) = 2



ROWS(Range)

Returns the number of rows in Range.

Example: ROWS(A1:B10) = 10



HLOOKUP(Searchltem; SearchRange; Rowindex)

Searchltem is compared against values in the first row of SearchRange. If a matching value is found, the contents of
the cell from the corresponding column and the Rowindex row is returned. If Searchitem can not be found in the
first row of SearchRange, the largest value that is less than Searchitem is used. Searchltem and the cells from the
first row of SearchRange may represent numbers or text. The data in the first row of SearchRange must be sorted in
ascending order. The Row/ndex numbering starts from 1 (the first row of SearchRange). If no matching value is
found, the error value is returned. The search in not case-sensitive.

Example: HLOOKUP(10251; B1:F4; 3) = 3




VLOOKUP(Searchltem; SearchRange; Columnindex)

Searchltem is compared against values in the first column of SearchRange. If a matching value is found, the
contents of the cell from the corresponding row and the Columnindex column is returned. If Searchltem can not be
found in the first column of SearchRange, the largest value that is less than Searchltem is used. Searchltem and the
cells from the first column of SearchRange may represent numbers or text. The data in the first column of
SearchRange must be sorted in ascending order. The Rowlndex numbering starts from 1 (the first column of
SearchRange). If no matching value is found, the error value is returned. The search in not case-sensitive.

Example: VLOOKUP(10252; A2:D7; 4) = "7/6/93"




INDEX(Range; ColumnNumber; RowNumber)

Returns the contents of the cell from Range. The cell position is relative to Range, i.e. ColumnNumber equal to 1
and RowNumber equal to 1 refers to the upper left corner of Range.

Example: INDEX(A1:B10; 1; 1) (= Al)



RANGE(LeftColumn; TopRow; RightColumn; BottomRow)

Creates and returns the cell range specified by two columns LeftColumn, RightColumn (1-512) and two rows
TopRow, BottomRow (1-8192).

Example: RANGE(1; 1; 2; 10) (=A1:B10)



MATCH(Searchltem; SearchRange; SearchType)

Searchltem is compared against values in the given range. If found, the position of the matching value is returned.
If there is no matching value, the error value is returned. The following search types may be specified:

0 - search for the first value equal to Searchitem

1 - search for the biggest value equal to or less than Searchitem

2 - search for the smallest value equal to or greater than Searchitem

Serachltem may represent a number or a text. The first position in SearchRange is equal to 1. SearchRange does
not have to be sorted. The search in not case-sensitive.

Example:
MATCH("victe"; A2:D7; 0) = 14
MATCH(10250.5; A2:A7; 1) = 3




ADDRESS(ColumnNumber; RowNumber)

Returns the cell address specified as ColumnNumber (1 - 512) and RowNumber (1 - 8192).

Example: ADDRESS(3; 4) (=C4)



CELL(FeatureType; CellAddress)

Returns the chosen feature of a cell. FeatureType may have the following values:
0 - cell column is returned

1 - cell row is returned

2 - cell value is returned

Example: CELL(0; B5) = 2



OFFSET(Range; ColumnsNumber; RowsNumber)

Returns Range shifted horizontally and/or vertically by ColumnsNumber and RowsNumber.

Example: OFFSET(A1:B10; 1; 1) (=B2:Cl11)



GETEXVAL(Document; CellAddress; AutoOpen)

Returns the value of the specified cell from another spreadsheet document. Document should contain the full path
of an existing *.gsc file. Before obtaining this value, Document must be opened. If AutoOpen is equal to 1,
Document is opened automatically. If AutoOpen is equal to 0 and Document is not loaded, the error value is
returned.

Example: GETEXVAL("d:\gscalc35\analyze.gsc"; E9; 1) = 100



TEST(Number; TrueValue; FalseValue)

If Number is greater than or equal to O, the TrueValue is returned. If Number is less than 0, FalseValue is returned.
TrueValue and FalseValue may represent any text or numbers.

Example: TEST(10; "abc"; "cde") = "abc"

Note: The "TEST", "ETEXT", "STEXT", "ROUNDE", "ROUNDO" functions are provided for compatibility with the earlier
version of GS-Calc. In GS-Calc 3.5 and later use respectively the "IF", "UPPER", "LOWER", "EVEN", "ODD" functions.



IF(Condition; TrueValue; FalseValue)

If Condition, which may be any expression returning numbers, is different than 0, the TrueValue is returned. If
Condition is equal to 0, FalseValue is returned. TrueValue and FalseValue may represent any text or numbers.

Example: IF((A1>1)*(A1l<10); 1;2) =1



ISERROR(Value)

Returns 1 (True) if Value represents the error value or a cells range containing at least one error value. If no error is
found, O is returned.

Example: ISERROR(1/0) =1



ISNUMBER(Value)

Returns 1 (True) if Value represents a number, cell or a cells range containing (only) numbers or expressions
returning numbers. Otherwise 0 (False) is returned.

Example: ISNUMBER(12) =1



ISSTRING(Value)

Returns 1 (True) if Value represents a text string or a cells range containing only text. Otherwise 0 (False) is
returned.

Example: ISSTRING("abc") =1



ISFILE(Text)

Returns 1 (True) if Text represents a name of an existing file or 0 (False) otherwise.

Example: ISFILE("d:\gscalc35\analyze.gsc") = 1



ISOPEN(Text)

Returns 1 (True) if Text represents a name (full path) of the currently open spreadsheet document or 0 (False)
otherwise.

Example: ISOPEN("d:gscalc35\analyze.gsc") = 1



PLAYSOUND(Condition; SoundName; Type)

If Condition, which may be any expression returning numbers, is different than 0, this function plays sound specified
as SoundName. If Type is equal to 1, SoundName is assumed to be a complete file path, otherwise it's treated as a
system sound name alias.

Example: PLAYSOUND(ISERROR(B15); "c:\sound\theme.wav"; 1)



OPENDOC(Condition; Document)

If Condition, which may be any expression returning numbers, is different than 0, this function opens a document
specified as Document. This can be a complete file path of the given document, executable file name, name of a
folder or an Internet URL.

Example:
OPENDOC(B15 > 10000; "d:\report.txt")
OPENDOC(B15="xyz";"http://www.xyz.com")



OPENSHEET(Condition; SheetName)

If Condition, which may be any expression returning numbers, is different than 0, this function opens an existing
spreadsheet document specified as SheetName. SheetName must contain a full path name of a given document.

Example: OPENSHEET(B15<100; "d:\form1.gsc")



MESSAGE(Condition; MessageText)

If Condition, which may be any expression returning numbers, is different than 0, this function displays a message
specified as MessageText.

Example: MESSAGE(ISERROR(B15); "Error Value in B15!")






Print command (File menu)

Use this command to print a document. This command presents a Print dialog box, where you may specify the range of pages to
be printed, the number of copies, the destination printer, and other printer setup options.



Print dialog box

See: Print command.



Print Progress Dialog

The Printing dialog box is shown during the time that GS-Calc is sending output to the printer. The page number indicates the

progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed. When you choose this command, the main
window will be replaced with a print preview window in which one or two pages will be displayed in their printed format. The print.
preview toolbar offers you options to view either one or two pages at a time; move back and forth through the document; zoom in
and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents the Print Setup dialog box where you
specify the printer and its connection.



Print Setup dialog box

See: Print Setup command.






Paste Link command (Edit menu)

Use this command to paste link. This command is inactive when the Clipboard doesn't contain any link.



Links command (Edit menu)

Use this command to display the Links dialog box which lets you edit links between your document and other documents.

This command is unavailable if you have no links in your document.



Links dialog box

See: Links command



Object verb (Edit menu)

After selecting an OLE object this command is replaced by a new menu. Its contents depends on what type of object you selected.



New Object (Insert menu)

Inserts and embeds an object in a document. The application in which the object was created becomes active on the screen.

Select the object you want to insert into your document using the Insert New Object dialog box.



Insert New Object dialog box

See: New Object.



Paste Special command (Edit menu)

Use this command to paste the Clipboard contents using one of the available formats.



Paste Special dialog box

See: Paste Special command



Update command

Use this command to update the currently edited GS-Calc objects which are not updated automaticaly.



Save Copy As... command

Use this command to create and save a new copy of the currently edited GS-Calc object.



OLE object frame

If you want to change the position or size of the currently edited OLE object, move or change the size of the frame displayed around
it.






